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SMS 13.0 Tutorial 

BOUSS-2D  

 

Objectives 

Learn to use the interface for BOUSS-2D and run the model for a sample application. This example steps 

through the process of setting up and running a simulation using data from the area around Kalaeloa 

Barbers Point Harbor in Hawaii  

 

Prerequisites 

 Overview Tutorial 

 

Requirements 

 Map Module 

 Cartesian Grid Module 

 Scatter Module 

 BOUSS-2D 

 

Time 

 15–25 minutes 

 

  

v. 13.0 
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1 Introduction 

As a phase-resolving nonlinear wave model, BOUSS-2D can be used in the modeling of 

various wave phenomena including shoaling, refraction, diffraction, full/partial reflection 

and transmission, bottom friction, nonlinear wave-wave interactions, wave breaking and 

dissipation, wave runup and overtopping of structures, wave-current interaction, and 

wave-induced currents.  

The data used for this tutorial includes images, bathymetry data, and coastline data for 

Kanaeloa Barbers Point Harbor, located on the southwest corner of the island of Oahu, 

Hawaii. 

2 Getting Started 

The cell-centered grid used for this tutorial was previously created. Open the background 

data for this project by doing the following: 

1. Select File | Open… to bring up the Open dialog.  

2. Browse to the data files\ folder for this tutorial and select “kalaeloa.sms”. 

3. Click Open to import the project and exit the Open dialog. 

The project should appear similar to Figure 1. For more information on how the grid was 

generated, see the “Creating a Cell-Centered Grid” tutorial. 

Before continuing, it is best to save the project under a new name in order to preserve 

the starting project for future use. 

1. Select File | Save As to bring up a Save As dialog.  

2. Enter the File name “BarbersPoint.sms” and click Save.  
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Figure 1      Initial project 

3 Generate a Wave Maker 

Wave makers are created through map coverages. To create a wave maker, follow these 

steps: 

1. Right-click on “  Map Data” in the Project Explorer and select New Coverage 

to open the New Coverage dialog. 

2. In the Coverage type section, select Models | BOUSS-2D | Wave Maker. 

3. Enter “Wave Maker” as the Coverage Name.  

4. Click OK to close the New Coverage dialog. 

5. Select “  Wave Maker” to make it active. 

6. Using the Create Feature Point  tool, create a point in the new coverage as 

indicated in Figure 2.  

 

      Figure 2      Wave Maker map coverage with feature point 
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4 Defining the Wave Maker 

The BOUSS-2D wave maker must be positioned at a point in the grid. In SMS, create the 

wave maker on a point at a desired location.  

To define a wave maker, follow these steps: 

1. Using the Select Feature Point  tool, select the newly created point. 

2. Right-click and select Node Attributes... to bring up the BOUSS-2D Wave 

Generator Properties dialog. 

3. In the Wave Simulation Parameters section, select “Irregular Unidirectional” 

from the Type drop-down.  

4. Enter “750.0” as the Series duration and press the Tab key. 

5. Click OK to acknowledge the message about changing the period for all wave 

makers. 

6. In the Spectral Parameters section, select “JONSWAP Spectrum” from the Type 

drop-down. 

7. Select “Specify hs and Tp” from the Option drop-down.  

This allows the significant wave height and peak period values (Hs and Tp) to be set as 

follows:  

8. In the spreadsheet, enter “3.0” as Sig. Wave Height (m).  

9. Enter “15.0” as Peak Wave Period (s). 

10. In the Directional Parameters, select “Meteorologic” from the Projection drop-

down. 

11. Enter “245.0” as the Wave angle. 

12. Leave all other parameters at their defaults. 

13. Click OK to close the BOUSS-2D Wave Generator Properties dialog. 

14. If asked, click the Yes button to force a constant elevation.  

As SMS generates the wave maker, this indicates that the offshore edge of the grid is not 

of constant depth. The wave maker should appear similar to Figure 3. 

 

Figure 3      Arrow indicates direction of waves from the wave maker 
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5 Creating a BOUSS-2D Simulation 

The next step in preparing a simulation is to specify model input parameters by first 

creating the BOUSS-2D simulation: 

1. Right-click on an empty space in the Project Explorer and select New Simulation 

| BOUSS-2D.  

2. Right-click on the newly created “  Simulation” item and select Rename. 

3. Enter “BarbersPoint” and press Enter to set the new name.  

4. Drag both “  10m Grid” and “  Wave Maker” under “  BarbersPoint”. 

5.1 Setting the Model Parameters 

With the initial setup for the simulation completed, it is now possible to define the 

model parameters. 

1. Right-click on “  BarbersPoint” and select Model Control… to bring up the 

BOUSS-2D Model Control dialog. 

2. Enter “Barbers Point Sample Run” as the Project title.  

3. In the Time Control section, enter “1500.0” as the Duration.  

This value should be greater than the computed default (the number in the Recommended 

column) in that field.  

4. Enter “0.25” as the Timestep.  

The default time step is set to correspond with a Courant number of “0.6”. Reducing the 

time step increases stability. The time step should not be increased. 

5. In the Parameters section, turn off Enable wave runup. 

6. In the Output Options section, turn on all options under Time independent. 

7. Under Animation Output, turn on Output WSE, Output Velocity and Override 

Defaults.  

For this case, first generate a series of solutions corresponding to the last five wave cycles 

(75 seconds) by changing the settings as follows: 

8. Enter “1425.0” for Begin output. 

9. Enter “1500.0” for End output. 

10. Enter “1.0” as the Step.  

The defaults for the above three parameters save the water level and velocity at even 

increments for the entire simulation. This generally results in either a huge output file or a 

discontinuous set of solution snap shots. An approximate size for the solution file is 

displayed to the left under Required memory. 

11. Click OK to close the BOUSS-2D Model Control dialog. 
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6 Defining Damping Layers 

If no damping is applied to the model, wave energy that is not dissipated along gradually 

sloping beaches will be bounced back into the domain. To calibrate to real world cases, 

or to prevent wave reflections from spreading back to the wave maker, it may be 

necessary to employ damping layers.  

BOUSS-2D uses a dataset with a damping value at each cell to compute the damping of 

waves. A damping value of “0.0” indicates no damping and is the default. As the 

damping value increases (up to “1.0”), and the number of damping cells adjacent to each 

other increases, the energy that is reflected back from the edge of the computation 

domain decreases. 

Damping layers are created in coverages by doing the following: 

1. Turn on “  Area Property” and select “  Elevation” under “  10m Grid” in 

the Project Explorer. 

2. Right-click on “  BarbersPoint” and select Generate Arcs Along Land 

Boundary… to bring up the Generate Arcs dialog. 

3. Select “Grid” from the Generate from drop-down. 

4. Click (none selected) next to Item to bring up the Select Tree Item dialog. 

5. Select “10m Grid” and click OK to close the Select Tree Item dialog. 

6. In the Destination coverage section, select Create New Coverage  

7. Select “Damping” from the Type drop-down. 

8. Enter “0” as the Elevation. 

9. Click OK to close the Generate Arcs dialog.  

This builds a new coverage called “Damping” that contains an arc along the boundary 

(Figure 4). 

10. Select “  Damping” to make it active. 

11. Using the Select Feature Arc  tool, double-click on the arc to bring up the 

Damping Properties dialog. 

12. Enter “20.0” as the Width (the combined width of two cells). 

13. Enter “0.2” as the Coefficient.  

14. Click OK to close the Damping Properties dialog. 

The width value for the damping depends on several factors including wave length and 

grid resolution. This small damping coefficient will reduce wave reflection inside the 

harbor.  

15. Click anywhere outside of the damping boundary arc to deselect it. 

Notice the “  Damping” has been automatically linked to the simulation. This is 

because the coverage was generated from the simulation. 
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      Figure 4      Boundary arc along the shoreline 

7 Saving and Running the Simulation 

The final step before running a simulation is to save the files for BOUSS-2D by doing the 

following: 

1. Select Save . 

This saves all the data files for execution. 

2. Right-click on “  BarbersPoint” and select Export BOUSS-2D.  

3. Right-click on “  BarbersPoint” and select Run BOUSS-2D to bring up the 

BOUSS-2D model wrapper dialog. 

4. If a Model Checker dialog appears with a warning that the selected run time is 

longer than the recommended time, click Run Model to exit the Model Checker 

dialog. 

If using a standard installation of SMS, the model should launch immediately. If SMS 

cannot find the BOUSS-2D executable, a message will be displayed asking to locate the 

desired executable. 

This simulation may take several minutes to run with a 0.25 sec time step, depending on 

the speed of the computer being used. The model run time increases or decreases linearly 

based on the number of computational cells. 

5. After the model run is complete, turn on Load solution and click Exit to close the 

BOUSS-2D model wrapper dialog. 

6. If the Dataset Time Information dialog appears, choose to use seconds for all 

datasets and click OK to exit the Dataset Time Information dialog. 

8 Visualize Simulation Results 

The model run created nine solution datasets that include spatially varying results at the 

grid nodes. Seven of these are scalar datasets:  

 Wave breaking animation (Breaking Animation) 

 Maximum Runup Height (Max. Runup Height) 
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 Mean wave level (Mean Water Level) 

 Mean wave directions (Mean Wave Direction) 

 Significant wave height (Sig. Wave Height) 

 Velocity magnitude animation (Velocity Animation Mag)  

 Water surface elevation animation (WSE Animation)  

The other two are vector datasets:  

 Mean Velocity 

 Velocity Animation  

BOUSS-2D can save these results in two ways: in multiple separate files, or in a single 

binary file (HDF5 format). In this case, BOUSS-2D created the file 

“BarbersPoint_sol.h5” at the end of the run. SMS creates a folder in the Project Explorer 

containing all of the datasets (in this case, “barberspoint”). 

To display a functional surface of the water surface: 

1. Select Display | Display Options… to open the Display Options dialog. 

2. Select Cartesian Grid from the list on the left. 

3. On the Cartesian Grid tab, turn off Cells and turn on Contours and Functional 

surface. 

4. Click Options… right under the Functional surface option to bring up the 

Functional Surface Options dialog. 

5. In the Dataset section, select User defined dataset to bring up the Select Dataset 

dialog 

6. Select “WSE Animation” from the list of datasets and click Select to close the 

Select Dataset dialog. 

7. In the Z Offset section, select “Display surface above geometry” from the drop-

down. 

8. In the Z Magnification section, turn on Override global value and enter “50.0” as 

the Magnification value. 

9. In the Display Attributes section, select Use solid color and click the larger Color 

button to bring up the Color dialog. 

10. Select cyan on the top row under Basic colors (fifth box from the left) and click 

OK to close the Color dialog. 

11. Click OK to close the Functional Surface Options dialog. 

12. On the Contours tab, in the Contour method section, select “Color Fill” from the 

first drop-down. 

13. Select “General” from the list on the left. 

14. On the General tab, turn off “Auto z-mag” in the Drawing Options section. 

15. Enter “20.0” as the Z magnification.  
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This amplifies the variation in the z-direction due to the very small wave heights 

compared to the size of the domain. 

16. On the Lighting tab, turn on Enable lights. 

17. Turn on Smooth edges in the Surface attributes for all lights section 

18. Click and drag the sphere until the dot is in the upper right quarter of the sphere, 

about a third of the way from the edge to the center of the sphere (see Figure 5). 

This will give good lighting contrast for the 3D view. 

 

      Figure 5      Lighting tab showing lighting direction 

19. On the View tab, select View angle and enter “40.0” as the Bearing and “25.0” as 

the Dip.  

20. Click OK to close the Display Options dialog. 

21. Select the “  Elevation” dataset in the Project Explorer to show the contour on 

the bottom of the ocean.  

The system may take a several minutes to update the display, depending on the 

capabilities of the computer. Figure 6 shows this functional surface of the water surface 

over the bathymetric surface. The contour colors may vary. In this case, the contours are 

set to display a hue ramp with blue at the maximum end and the depth function active. 
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      Figure 6 Water level functional surface over the bathymetry (magnified 20x) 

All of the standard visualization methods described in the “Data Visualization” tutorial 

also work for the solutions generated by BOUSS-2D. Experiment with other options to 

view the solution. 

9 Conclusion 

This concludes the “BOUSS-2D” overview tutorial. Feel free to continue experimenting 

with the SMS interface, or exit the program. 


